<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
<th>Responsible Party</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software hazards</td>
<td>Includes software changes, software hazard analysis</td>
<td>Paul Boldon, Sharyl Butler (JSC), Martha Wetherholt, IV&amp;V Ctr</td>
</tr>
<tr>
<td>SMA Policy</td>
<td>Emergency Preparedness, system safety, R&amp;M, mishap investigation, etc.</td>
<td>Wil Harkins, Jon Mullin</td>
</tr>
<tr>
<td>Contingency Planning</td>
<td>A post-mishap look at correctness/effectiveness of our contingency plans; do we need updates/changes?</td>
<td>Gill White</td>
</tr>
<tr>
<td>NASA Safety Reporting System (NSRS), Alerts</td>
<td>Includes any NSRS reports or alerts pertaining to foam, tile, ingredients, etc., as well as any current Shuttle-related reports</td>
<td>Eric Raynor</td>
</tr>
<tr>
<td>Lessons Learned</td>
<td>Are there any pertinent LL in the database? Ensuring that these new lessons get into the LLIS in the long run.</td>
<td>Eric Raynor</td>
</tr>
<tr>
<td>SMA Reviews and Assessments</td>
<td>OEP, PV, FMR spot checks, staff assistance visits, other periodic center visits (including MAF)</td>
<td>Steve Newman, Art Lee, John Lyver</td>
</tr>
<tr>
<td>Aerospace Advisory Panel</td>
<td>Includes any pertinent findings</td>
<td>Len Sirota</td>
</tr>
<tr>
<td>Training</td>
<td>Of workers on the floor—certification and training for insulation application, repair, etc.</td>
<td>Eric Raynor</td>
</tr>
<tr>
<td>Life extension program</td>
<td>We were about to benchmark what USAF does for aging aircraft. Any implications for what NASA does?</td>
<td>Tom Whitmeyer, SLEP Panel (Obs.&amp; Sustainment), Bill Bihner, John Castellano</td>
</tr>
<tr>
<td>Mishap Investigation protocol and methodology</td>
<td>Supporting with info on NPDs, NPGs, root cause methods, training for MIB members, briefing packages, etc.</td>
<td>Wayne Frazier, Faith Chandler</td>
</tr>
<tr>
<td>Human Factors</td>
<td>What opportunities were there for human factors to contribute to the mishap?</td>
<td>Faith Chandler</td>
</tr>
<tr>
<td>Post-mishap implications for ISS</td>
<td>Keeping up-to-date information on affect of this mishap on ISS supportability, etc.</td>
<td>Rich Patrican, Gil White</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>MIB Web-based work group area</td>
<td>PBMA work group to support information and communication needs of the MIB, including IT security of the posted/transmitted information</td>
<td>Steve Newman, Steve Wander</td>
</tr>
<tr>
<td>DoD data</td>
<td>Data that DoD might have that could be useful</td>
<td>Mike Card</td>
</tr>
<tr>
<td>Space Shuttle Manufacture</td>
<td>Background and details of the manufacturing process.</td>
<td>Len Sirota</td>
</tr>
</tbody>
</table>
X-Authentication-Warning: spinoza.public.hq.nasa.gov: majordom set sender to owner-code-q using -f
X-Sender: prutledg@mail.hq.nasa.gov
X-Mailer: QUALCOMM Windows Eudora Version 4.3.2
Date: Tue, 04 Feb 2003 12:20:54 -0500
To: jilloyd@hq.nasa.gov
From: Pete Rutledge <prutledg@hq.nasa.gov>
Subject: Fwd: Questions/issues for Bryan's use
Cc: code-q@lists.hq.nasa.gov
Sender: owner-code-q@lists.hq.nasa.gov

Jim,

Attached is first batch of questions/issues for Bryan's use on the Columbia Accident Investigation Board. These are a combination of inputs from SMA Directors and from OSMA staff members; Pam Richardson is pulling them together and maintaining the list. We would propose that you send to Bryan deily-only the new questions/issues (to minimize e-mail download time on Bryan's end). They are numbered sequentially and in chronological order, so it will be easy to send just the new ones. By means of this e-mail, I'm sending the list of questions/issues to all OSMA staff members. As Ron Moyer suggested, seeing these questions/issues may prompt thoughts of new ones.

Suggest sending this batch to Bryan ASAP.

Thanks,

Pete

---

Pamela F. Richardson
Aerospace Technology Mission Assurance Manager
Enterprise Safety and Mission Assurance Division, Code QE
Office of Safety and Mission Assurance, NASA Headquarters
300 E. Street, S. W., Washington, DC 20546
phone: 202-358-4631, fax: 202-358-2778

"The meek can have* the Earth. The rest of us are going to the stars." — Robert Heinlein
"We have to learn to manage information and its flow. If we don't, it will all end up in turbulence." — RADM Grace Hopper
questionsforbryan.doc

Peter J. Rutledge, Ph.D.
Director, Enterprise Safety and Mission Assurance Division
Acting Director, Review and Assessment Division
Office of Safety and Mission Assurance
NASA Headquarters, Code QE, Washington, DC 20546

ph: 202-358-0579
FAX: 202-358-2778
e-mail: pete.rutledge@hq.nasa.gov

Mission Success Starts with Safety!
You will notice I finessed my chart to show we do have an odd number of members. The intent of the NPG when we wrote it (I remember having the discussion with Aaron) was that the Exec Sec was to be a voting member, so with we were working to the supposition that they have 9 members (with the additional chair from SO’K). According to Laura Giza in legal, the exec is not normally voting so I had to finesses it to show we had 7 members under the chair. I'll put this on the list of things we need to clarify in the NPG rewrite whenever we get to it again.

W
Wayne R. Frazier  
NASA Headquarters - Code QS  
Office of Safety and Mission Assurance  
Washington, DC 20546-0001  
Ph: 202 358-0588 Fax: 202 358-3104  

"Mission success starts with safety"
Would it be possible for us (Code Q) to see (as soon as available) the fault tree that has been prepared for a presentation to the CAIB on Wednesday? We would like to see it from the viewpoint of fault tree methodology, as well as hardware, software, and human error modelling. We have people with the necessary expertise here. And certainly we all want the best and most thorough product for the CAIB.

Thanks,

Pete

Peter J. Rutledge, Ph.D.
Director, Enterprise Safety and Mission Assurance Division
Acting Director, Review and Assessment Division
Office of Safety and Mission Assurance
NASA Headquarters, Code QE, Washington, DC 20546

ph: 202-358-0579
FAX: 202-358-2778
e-mail: pete.rutledge@hq.nasa.gov

Mission Success Starts with Safety!
We've asked for it -- will send when we get it.
bba for Bill H.

At 12:14 PM 2/10/2003 -0500, Pete Rutledge wrote:

   HCAT,

   Would it be possible for us (Code Q) to see (as soon as available) the fault tree that has been
   prepared for a presentation to the CAIB on Wednesday? We would like to see it from the
   viewpoint of fault tree methodology, as well as hardware, software, and human error modeling.
   We have people with the necessary expertise here. And certainly we all want the best and most
   thorough product for the CAIB.

   Thanks,

   Pete

____________________________________________________________________________________

Peter J. Rutledge, Ph.D.
Director, Enterprise Safety and Mission Assurance Division
Acting Director, Review and Assessment Division
Office of Safety and Mission Assurance
NASA Headquarters, Code QE, Washington, DC 20546

ph: 202-358-0579
FAX:202-358-2778
e-mail: pete.rutledge@hq.nasa.gov

Mission Success Starts with Safety!
At 03:35 PM 2/11/2003 -0500, James Lloyd wrote:

Pam sent you a single annotated slide earlier supporting her theory that something may have started in the wheel well area (I would say started in or around). A series of charts that Rich received today give one a clear idea of the time sequencing of off nominal and drop outs of sensors (both P and T). Run it fast like an animation and you will see the progression of events.

Jim:

Here's an "auto-animated," cleaned-up, pps file.

Click on it to run it.

John Lemke
Manager, System Safety Engineering
NASA HQ, Code QS
202-358-0567 FAX 358-3104
jemke@mail.nasa.gov

"Mission success stands on the foundation of our unwavering commitment to safety"
Administrator Sean O'Keefe January 2003

[Attached file: columbia sensor wire locations Rev 1.ppt]
Dear SMA Directors,

I am postponing today’s SMA teleconference until tomorrow (Wednesday) at 1 pm est.

Jim Lloyd
To: Pete Rutledge
From: Faith Chandler <fchandle@hq.nasa.gov>
Subject: Re: Question/issue for Bryan
Cc: prutledge@hq.nasa.gov
Bcc:
Attached:

Pam,

Per Pete's request:
Here are some quick thoughts.

The foam insulation could have produced damage for a number of reasons. One possibility is that the foam was denser than originally believed, consequently making the analysis inaccurate.

The materials could have been denser/harder than originally believed due to some of the following:
   a) Problems with the quality/age of the material used (perhaps the materials used to produce the foam insulation were not
      the type, chemical composition, or quality that were required).
   b) Changes/errors in the manufacturing process.
   c) Problems with the quality, age, or type of adhesive materials used (if any).
   d) Changes/errors in applying the foam.
   e) Changes/errors in preparing the ET surface (Perhaps paint or other came off the ET when the foam came off during
      launch).
   f) Debris (e.g., FOD or other material) intentionally or unintentionally placed under the foam.
   g) Changes/errors in final preparation of the outer foam surface after application.
   h) Ice build up on the foam.
   i) Another possibility is that other debris was flying in the same air stream as the foam (perhaps behind it) and this (which
      may not have been visible to the camera because the foam blocked the view) may have caused significant damage.

At 08:30 PM 2/3/2003 -0500, you wrote:
   Faith,

   Please write down and send to Pam your idea about ET foam insulation possibly being harder/denser than normal, allowing it to create more damage than expected.

   Thanks,

   Pete
To: Mkowales@hq.nasa.gov, jlloyd@hq.nasa.gov, prutiedg@hq.nasa.gov
From: Faith Chandler <fchandle@hq.nasa.gov>
Subject: CAC meeting notes
Cc: Pepper Phillips <pphllip@mail.hq.nasa.gov>
Bcc:
Attached: C:\Documents and Settings\chandle\My Documents\Columbia\Action Plan\Columbia
Action Committee.doc;

Here are the notes that I took during the Friday (2-7-03) Columbia Action Committee meeting (CAC).

Note the CAC will meet each day at 2:00.
Support Tools for the CAIB

There are at least two NASA tools that are available for use by the Columbia Accident Investigation Board. These two tools provide different capabilities and features that can all be of value to the process.

Investigator Organizer (IO) - prototype

IO is a software tool that provides the capability to store and link large amounts of data and to present that data in a graphical format.

The goal of IO is to enable a systematic investigation process through improved storage and structuring of information gathered and analyzed by distributed teams of mishap investigators. It allows the team to optimize investigation decisions and tasks by tracking the investigation through a framework of causal models. It maintains project information on the web, incorporates interfacing capabilities and facilitates maintenance of relationships between data.

It has a new; although somewhat limited, fault tree construction capability. It will allow potential causes on the fault tree to be linked to shuttle parts, debris found in the field, analysis reports, other fault trees, FMEAs, hazard analysis, etc. Once data is entered into IO, it allows easy search from one thread through all related and connected data.

Disadvantage of the tool is that its user interface is very difficult to use. Consequently, it is best used if supported by the team of developers from ARC. Currently, two ECS IO developers are in Shreveport, to support Dave Whittle’s team and share information about the tool.

Process Based Mission Assurance Knowledge Management System (PBMA)

PBMA is a web-based tool that allows a user group, such as the Columbia Accident Investigation Board to organize and plan all of their activities, store documents and communicate with the Task Force. It provides features such as a working group calendar, polls (surveys), open discussion, document storage, team contact information, and capability to link to various needed sites on the web.

It allows multiple members to edit documents in real time, by providing access, checkout capability, and edit capability.

PBMA provides the team with the capability to set permissions on folders and/or documents within the site, controlling access to subgroups.
PBMA is bringing online an ultra-secure site that should be available Mon-Tues (February 10-11). This site will be suitable for ITAR and Mishap Investigation Data.

Comparison & Contrast

Both tools provide access from anywhere because they are web based.

The PBMA website could be used to allow the Task Force a central location to store Columbia Accident Investigation data, post meeting times, maintain a list of all subgroups, their members and contact information, make inquiries to the groups, and store all investigation related material. It could be a conduit by which the Task Force and the CAIB communicate and share data.

In contrast, the IO would be used to take data/documents on the PBMA site and link them in a logical order, to the fault tree as the analysis takes place. It provides a specific capability that allows linking between various data elements that may facilitate the investigation. It would primarily support the work of the CAIB executive secretary.

The tools together provide complementary capabilities.
Pam,
I was asked to attend the CAC today.
Here are my notes from that meeting.

Date: Fri, 07 Feb 2003 15:42:46 -0500
To: Mkowales@hq.nasa.gov, jlloyd@hq.nasa.gov, prutledg@hq.nasa.gov
From: Faith Chandler <fchandle@hq.nasa.gov>
Subject: CAC meeting notes
Cc: Pepper Phillips <pphillip@mail.hq.nasa.gov>

Here are the notes that I took during the Friday (2-7-03) Columbia Action Committee meeting (CAC).

Note the CAC will meet each day at 2:00.
Columbia Action Committee (CAC)
Friday 2-7-03

Meeting Notes

Ashley Stockinger will send all completed responses to Michael Greenfield.
Michael will review and concur.
Michael will return to Ashley.
Ashley will distribute to source from which the question came.
(A flow diagram is posted on the wall in the CAC illustrates the process).

CAC’s task: Perform all HCAT responsibilities dealing with external responses.
HCAT will retain responsibilities dealing with internal responses.

Question (by Michael): How are we handling companies that send us information and want us to use their products on the Columbia Investigation?

Answer (by Helen- Code L) = Send the information to Code K. They handle small business.

Question (by Michael): How are we handling condolences?
Answer (by Rich Cooper – Code P): These should go to Rich Cooper at Code P. They should not go to the CAC.

Question (by Helen): In the past Code L prepared the briefing book for the administrator. It appears that others are involved (e.g., Code G, Code P). What is Code L’s role in the preparation of the briefing book? Seems to be lots of duplication of effort.

Discussion (by Rich Cooper): Yes. We got a call. Glen Mahone asked Code P to assemble background material of the Columbia Investigation to date. That is all information (RTQs) that had already been released and approved. (e.g., on astronauts, their families, etc). We are putting that together for the administrator.

Question (reiterated by Michael): Who has the lead to put together the briefing for the administrator? Where is Code L in the process?

Discussion (Michael): Meeting on Saturday 4-6. Paul Pastorek will go through all the questions in the preparation session.

Discussion (All) – CAC working all approved stuff and putting it into the CAC database. The database will be available to develop the briefing book.

Question (Helen): Who is doing the things in Ashley’s memo?
Answer (Michael): It is not CAC’s responsibility to send tasks out like through Ashley’s memo. Will be done differently.
Discussion (Rich): Code P is taking the approved existing information and making RTQs (this is a subset of Paul P.'s activities). Rich is also trying to get all the RTQs that have already been done (before today), collect them and get them for inclusion in the database. The plan is to print a complete set once this is done.

Discussion (Ashley): No new CAC actions received today.
Discussion (Michael & Helen): Anticipated that there will be many RTQs after Congressional hearing.

Action (given by Michael): Code Q to have RTQs to Michael (and to Ashley Stockinger) by 5:00 close of business today. RTQs do not have to be in standard format for this release.

(Code P provided sample format for RTQ... this was provided to Jim Lloyd after the meeting).

Other information going into the CAC database:
- Press releases
- Mission status reports for each day.
- Budget information
- Transcripts from all televised discussions on Space Shuttle

Sunday there will be a preparation session for the administrator (for Congressional hearing).
To: Rutledge_Peter  
From: Faith Chandler <fchandle@hq.nasa.gov>  
Subject: Question for Columbia Investigators  
Cc: prichard@hq.nasa.gov  
Bcc: 

Attached:

Pete,

Here is a question/thought for the Columbia Accident Investigation Board.

Columbia underwent major modifications, which included changes to the leading edge of the wing. These are documented in reports on the following site.  
See vehicle engineering report sts-109 (Columbia's return to flight after major upgrades).

What potential human errors during these modifications could have contributed to/caused this accident?
HCAT@hq.nasa.gov, 10:23 AM 2/11/2003 -0500, Fwd: FW: Columbia Investigation

To: HCAT@hq.nasa.gov
From: Faith Chandler <fchandle@hq.nasa.gov>
Subject: Fwd: FW: Columbia Investigation
Cc: prichard@hq.nasa.gov
Bcc:
Attached: C:\Documents and Settings\chandle\My Documents\attach\License Plate Tutorial.pdf;

HCAT,

See note below: A suggestion that Cognitech may have some capability to assist in the forensic analysis of video.
Mike Jones is a former NTSB accident investigator.

From: "Jones, Mike" <MEJones@comdt.uscg.mil>
To: "Faith Chandler (E-mail)" <fchandle@hq.nasa.gov>
Subject: FW: Columbia Investigation
Date: Tue, 11 Feb 2003 10:04:27 -0500
Importance: high
X-Mailer: Internet Mail Service (5.5.2653.19)

Faith,

How are efforts going to enhance video of the Columbia breakup? I know someone who may be able to help. of Integradyn, Inc., has worked with the astronaut office in Houston for 4 years and knew and worked closely with Rick Husband. I've also known Aerospace Experimental Psychologist CDR USN Retired, since coming to Washington.
Please read below:

Regards,

----Original Message----
From:
Sent: Monday, February 10, 2003 9:06 AM
To: Jones, Mike
Subject: Columbia Investigation

Mike,

I have a good friend ....... who is CEO of a small company that specializes in forensic analysis of video. The company is Cognitech (http://www.cognitech.com/).

Attached is an example of a tutorial from their website. Note the pictures on the last two pages. They illustrate the kind of powerful results that can be achieved from Lenny's sophisticated tools.
I firmly believe that Cognitech could add significantly to the Columbia Investigation by applying their techniques to several of the launch and entry videos.

If you happen to have a discussion with your contact at NASA/HQ, it would be a significant service to add Cognitech to the mix.

I have probably told you about [deleted] before, but if not -- 

also did analysis on a home movie of the B-52 crash up in Wash. State some years ago. And he did work for the Navy on the F-14 ramp strike by a female pilot.

Cognitech has several DoD and CIA clients, but they are not currently doing anything for NASA.

Anyway, if you get a chance to make the suggestion, I believe [deleted] is the right guy to deblur the launch video. NASA's current efforts -- based on averaging of 10 frames -- is guaranteed to obscure any damage. The attached pdf illustrates one alternative that [deleted] can bring to bear.
Tutorials

License Plate Mosaic

This tutorial explains how to use Velocity and Mosaic Reconstruction to combine a movie's frames with incomplete information into a single frame that combines all of the information of a particular object in a the frame, across all of the frames where the object appears.

The data used is the plate_movie.cif file that shipped with Video Investigator version 1.0. It can be found on the CD-ROM, under the Data directory. Open this movie in Video Investigator. First launch Video Investigator, then click File->Open.

Move to the CD-ROM drive, go into the Data directory, and double-click on plate_movie.cif.
The movie should look like this:

This file contains a movie of a car license plate taken from a darkened parking garage. As you can see, no single frame of this movie contains readable information. But, all of the frames combined could give us a readable image.
There is some movement in the movie. Video Investigator comes with a series of Filters that can track the velocity of objects in movies. We need to compute this movie’s velocity before merging the frames, so that the reconstruction filters know which objects from one frame are similar to objects in the next frame.

On the left side of Video Investigator’s screen is a toolbar, which looks like this:

The last image is the Glyph Tool. Click on it.

The Glyph Tools toolbar will appear below the main toolbar:

The fifth icon from the top of this toolbar is the Rectangle Glyph Tool. Click on it.

Glyphs are a method of selection that is frame dependent, but are time and space aware. Each frame of a movie can have different selections, using Glyphs. We need to isolate the important area of our movie using the Rectangle Glyph tool.

First, pause the movie from the Movie Controller. Then, drag the frame indicator to frame 1 of the movie, or rewind the movie.
Starting at the upper left part of the license plate, hold down the left mouse button and drag to the lower left corner of the license plate.

Now go to Filters>Velocity>Correlation Matching
Other filters can be chosen as well, see the Users Manual for information on the Velocity Filters. The following dialog box should appear:

These are the parameters that the Correlation Matching Filter needs in order to operate. The first change we need to make is to click the “Track Matching Window” box. This will take our Glyph Rectangle and move it according to the movement of the objects within the rectangle. Next, the Velocity Characteristics need to be all un-checked. There is little to no rotation, zoom, shear, or projection in this movie, and so we do not need to complicate matters by having the Filter adjust for such occurrences. Your modified parameters should look like this:
Click OK to start estimating velocity. The progress bar in the lower left corner indicated the progress of the filter.

When the filter is done, the progress bar will disappear.

After the filter is done processing, click on the Component Information Viewer. This is located at the top of the screen.
This window will appear within Investigator. It shows the components of this movie. As you can see, the movie now contains two components. The first is the actual image data. The second, "CorrAffMap", is the velocity information. This is not a viewable component, but merely a data structure filled with affine velocity information which allows for translation, rotation, zoom and shear.

Now that we have confirmed that our velocity is contained within our movie, we can begin to reconstruct a single frame containing all of the information of the entire movie.

Go to Filters->Reconstruction->Mosaic Reconstruction.
Here, we can change the Patching Method to Min Distance. Then select OK. Note that Equal Weight can be chosen as well. The Min Distance will combine frames preferentially with larger weights depending on time distance from the center frame, in this example Frame 1. Equal Weight will combine all frames with equal weight.

Again, the progress bar will appear in the corner, and also a new image will appear in Investigator. This new image, named “Mosaic Construction” is where the output of the Mosaic filter is placed. As the filter processes, you can see more and more information enter into the “Mosaic Construction” image. When the filter finishes, you should end up with a constructed image similar to this:

The license plate reads 3UXC915. More processing could be done on this image to further enhance it, if needed.

As a counter-example, the traditional method of attaining this information is by a process called “Averaging Frames”. As the name implies, this technique takes all the information in a movie, and applies mathematical averaging from one frame to the next to produce a
final averaged image. Video Investigator supports this technique. You can find this filter under Filters->Simple Operation->Average.

Run it on the original movie, and you end up with this output:

![Average Filter Output]

As you can see, computing the velocity and using the Mosaic method gives you a far superior output.
Importance: High

Gentlemen:
Here is a STS-107 scenario that I thought of and I believe it deserves consideration for further analysis.
The important points of this scenario are that
1. damage incurred in the ascent phase continues and is built upon in the reentry phase, and that
2. heating in damaged area causes hot spots, i.e., higher thermal and structural loads than heating of smooth surfaces.
I am not sure if you considered this sequence in your shuttle PRA analyses.
Let's discuss it at the 11:30 EST telecon.

Michael

Message-ID: <A3B2C545704E3E429C597334E9456EE3060194B7@jsc-mail01.jsc.nasa.gov>
From: "MARSHALL, YOLANDA Y. (JSC-NA) (NASA)" <yolanda.y.marshall@nasa.gov>
To: 'boconnor' <boconnor@hq.nasa.gov>
Cc: "ERMINGER, MARK D. (JSC-NC) (NASA)" <mark.d.erminger@nasa.gov>,
"CAZES, DAVID (JSC-NA) (SAIC)" <david.cazes1@jsc.nasa.gov>,
"RAILSBACK, JAN (JSC-NX) (NASA)" <jan.railsback-1@nasa.gov>
Subject: RE: airborne sensor to detect/map Colombia debris
Date: Mon, 3 Feb 2003 07:10:45 -0600
MIME-Version: 1.0
X-Mailer: Internet Mail Service (5.5.2653.19)
Content-Type: text/plain;
    charset="iso-8859-1"

Bryan,

As the leader of the vehicle engineering fault tree team, our primary task is to take all the fault trees from the system models that we have and review them with the problem resolution teams (which includes S&MA, engineering, and subsystem managers). The effort is to focus the comprehensive fault trees that we have done to the accident scenarios that lead to loss of vehicle during early entry.

We are initially focusing on flight control/GNC, hydraulics/APU, thermal protections, structures, landing gear, and MM/OD. Note: Our debris model includes debris from the other Shuttle elements, but our model does not define the specific source of the debris. The weekend was used to isolate the information from the existing model. We will working today to define a
better schedule for completion and to coordinate with other organizations involved. I should be able to give you a status of where we are on the activity and when we can give you this information by noon today.

Jan Railsback will be the focal point for the PRA.

-----Original Message-----
From: boconnor [mailto:boconnor@hq.nasa.gov]
Sent: Monday, February 03, 2003 6:27 AM
To: MARSHALL, YOLANDA Y. (JSC-NA) (NASA)
Cc: 
Subject: Fwd: airborne sensor to detect/map Colombia debris

Yolanda,

Second, while we are getting organized, we do not yet have a good way to handle these requests to help. Could you please see that Laurel Kirkland of LPI gets her input into Dave Whittle's team's hands.

Third, I need someone smart on the PRA to pull out of the current Shuttle PRA a list of all the accident scenarios that lead to loss of vehicle during early entry. I imagine it will show things like SRB and ET debris, MMOD, APU hydraulic failures, GNC, etc. Mark Erminger has already culled out the hazreps, and the PRA may help us organize our thoughts more. You can email the list directly to me.

Thanks,

>From:
>To: "boconnor@mail.hq.nasa.gov" <boconnor@mail.hq.nasa.gov>
>Cc: "jlloyd@mail.hq.nasa.gov" <jlloyd@mail.hq.nasa.gov>
>Subject: airborne sensor to detect/map Colombia debris
>Date: Sun, 2 Feb 2003 17:20:00 -0600
>X-Mailer: Internet Mail Service (5.5.2653.19)
>
>Hi Mr. O'Connor,
Our group works with an airborne remote sensing instrument that is used to
detect and map gases real-time, such as those potentially leaking from
Colombia debris. It can also identify solid-phase materials. The sensor
is used for Department of Defense

and is particularly sensitive to searching for small gas-phase plumes. It
has flown for several years in intensive DoD
also mapped the World Trade Center debris field. It's primary strength is
aiding a focused search of selected areas, including regions that are
difficult to search by land.

We are willing to aid the Colombia search and mapping effort, but we are
not
trying to push ourselves into the recovery process. Rather, we are
indicating that we have some potentially helpful airborne technology and
would provide assistance if asked. We calculated the sensitivity for
the gases of interest, and I will send that and additional information if
it
is helpful. is an airborne thermal infrared hyperspectral scanner.

Sincerely,

Lunar and Planetary Institute
3600 Bay Area Blvd.
Houston, TX 77058-1113

O'C

Bryan O'Connor
Associate Administrator
Office of Safety and Mission Assurance
RAILSBACK, JAN (JSC-NX) (NASA), 09:06 AM 2/3/2003 -0600, RE: Sequence

Bryan O'connor Request.ppt
To: boconnor <boconnor@hq.nasa.gov>
From: Faith Chandler <fchandle@hq.nasa.gov>
Subject: Fwd: Re: Fwd: MORT
Cc:
Bcc:
Attached:

Bryan,

I will be working in the QMIC as part of the SMA Action Team. Consequently, I will be away from my desk most of the day. However, I can be reached by my Wayne and I will be developing the presentation from the QMIC and any suggestions are appreciated.

Thanks.
Have a great day.

Date: Mon, 03 Feb 2003 09:11:23 -0500
To: boconnor <boconnor@hq.nasa.gov>
From: Faith Chandler <fchandle@hq.nasa.gov>
Subject: Re: Fwd: MORT

Bryan,

I keep us posted.

At 07:58 AM 2/3/2003 -0500, you wrote:
Faith,
Thanks again, and be prepared for a briefing soon. Be aware that whoever on the board is assigned as the keeper of the analysis may have his own druthers on approach, but it would not hurt to have you folks available to help me decide if it is consistent with the intent of our policy.
Best,

At 07:17 AM 2/3/2003 -0500, you wrote:
Bryan,

Wayne and I are putting together some preliminary charts on NASA Investigation Policy that may be of assistance. We are here to assist you in what every you or the team may need.

At 07:00 AM 2/3/2003 -0500, you wrote:
Faith,
Thanks, we are probably still another day or two from deciding on our analysis technique. I'll keep this and Larry Gregg himself as an asset in mind.
Thanks,
At 12:33 PM 2/2/2003 -0500, you wrote:

Bryan,

Here are some overview charts on "MORT" from the NSTC instructor Larry Gregg.

From: "GREGG, LARRY (JSC-NT) (MEI)" <larry.gregg1@jsc.nasa.gov>
To: "fchandle@mail.hq.nasa.gov" <fchandle@mail.hq.nasa.gov>
Cc: "JOHNSON, ELMER R. (JSC-NS) (NASA)" <elmer.r.johnson@nasa.gov>
Subject: MORT
Date: Sat, 1 Feb 2003 11:50:13 -0600
X-Mailer: Internet Mail Service (5.5.2653.19)

Attached is the section of the M1 class where I talk about MORT. There are a few cartoons and such, and I just left them in there. Please feel free to contact me directly if there is ANYTHING I can do.

<<MORT.ppt>>

Larry Gregg
281-244-1278

-------------------------

Faith Chandler

NASA Headquarters
Office of Safety and Mission Assurance
Code Q Rm 5x40
300 E Street, S.W
Washington, D.C 20546

202-358-0411
202-358-2778 (fax)

-------------------------

O'C

Bryan O'Connor
Associate Administrator
Office of Safety and Mission Assurance
Faith Chandler

NASA Headquarters
Office of Safety and Mission Assurance
Code Q Rm 5x40
300 E Street, S.W
Washington, D.C 20546

202-358-0411
202-358-2778 (fax)

O'C

Bryan O'Connor
Associate Administrator
Office of Safety and Mission Assurance
To: boconnor <boconnor@hq.nasa.gov>
From: Faith Chandler <fchandle@hq.nasa.gov>
Subject: Re: Fwd: MORT
Cc:
Bcc:
Attached:

Bryan,

I keep us posted.

At 07:58 AM 2/3/2003 -0500, you wrote:
Faith,
Thanks again, and be prepared for a briefing soon. Be aware that whoever on the board is assigned as the keeper of the analysis may have his own druthers on approach, but it would not hurt to have you folks available to help me decide if it is consistent with the intent of our policy.
Best,

At 07:17 AM 2/3/2003 -0500, you wrote:
Bryan,

Wayne and I are putting together some preliminary charts on NASA Investigation Policy that may be of assistance.
We are here to assist you in whatever you or the team may need.

At 07:00 AM 2/3/2003 -0500, you wrote:
Faith,
Thanks, we are probably still another day or two from deciding on our analysis technique. I'll keep this and Larry Gregg himself as an asset in mind.
Thanks,

At 12:33 PM 2/2/2003 -0500, you wrote:
Bryan,

Here are some overview charts on "MORT" from the NSTC instructor Larry Gregg.

From: "GREGG, LARRY (JSC-NT) (MEI)" <larry.gregg1@jsc.nasa.gov>
To: "fchandle@mail.hq.nasa.gov" <fchandle@mail.hq.nasa.gov>
Cc: "JOHNSON, ELMER R. (JSC-NS) (NASA)" <elmer.r.johnson@nasa.gov>
Subject: MORT
Date: Sat, 1 Feb 2003 11:50:13 -0600
X-Mailer: Internet Mail Service (5.5.2653.19)

Attached is the section of the M class where I talk about MORT. There are a few cartoons and such, and I just left them in there. Please feel free to
contact me directly if there is ANYTHING I can do.

<<<MORT.ppt>>>

Larry Gregg
281-244-1278

--------------------------

Faith Chandler

NASA Headquarters
Office of Safety and Mission Assurance
Code Q  Rm 5x40
300 E Street, S.W
Washington, D.C 20546

202-358-0411
202-358-2778 (fax)

--------------------------

O'C

Bryan O'Connor
Associate Administrator
Office of Safety and Mission Assurance

--------------------------

Faith Chandler

NASA Headquarters
Office of Safety and Mission Assurance
Code Q  Rm 5x40
300 E Street, S.W
Washington, D.C 20546

202-358-0411
202-358-2778 (fax)

--------------------------
O'C

Bryan O'Connor
Associate Administrator
Office of Safety and Mission Assurance
To: boconnor@mail.hq.nasa.gov  
From: Faith Chandler <fchandle@hq.nasa.gov>  
Subject: Investigation Overview  
Cc: prutledg@hq.nasa.gov, wfrazier@mail.hq.nasa.gov, jilloyd@hq.nasa.gov  
Bcc:  
Attached: C:\Documents and Settings\fchandle\My Documents\Columbia\CAIB Bryan.ppt;  

Bryan,

Here is an overview of accident investigation methodology.  
It can be presented after Wayne's overview of NASA policy.

At the back, I have also included a quick over presentation of MORT.  
I can provide additional information on other analysis techniques and/or examples if desired.

Please let me know if you would like to see more or less information.

Any information and/or guidance is appreciated.  
Thanks.
February 4, 2003

Policy and Methodology

NASA Mishap Investigation
Agenda

Mission Success Starts With Safety

- Summary Report
- Root Cause Analysis
- Time Line, Fault Tree, Event & Causal Factor Tree
- Data Collection
- Investigation Tools & Methods
- Board's Tasks
- Purpose of Investigation
- NASA Policy & Guidelines
Purpose of Investigation

• The purpose of NASA mishap investigation process is solely to determine cause and develop recommendations to prevent recurrence.

• This purpose is completely distinct from any proceedings the agency may undertake to determine civil, criminal, or administrative culpability or liability, including those that can be used to support the need for disciplinary action.

*NASA Policy Directive (NPD) 8621.1H*
Mission Success Starts With Safety

Board’s Responsibilities

• Conduct activities in accordance with direction from NASA Administrator.
• Use established NASA support structure for working groups.
• Activate the working groups as appropriate to the mishap.
• Impound property, equipment, and records as necessary.
• Obtain and analyze relevant facts, evidence, and opinions.
• Determine facts (what happened), as well as probable causes.
• Identify & document findings: causes, contributing causes, potential causes, and pertinent observations. (Evaluate ALL possible reasons "why" it happened.)
• Develop recommendations to preclude recurrence of a similar mishap and other appropriate actions.
• Provide a final written report.

*Per letter to Admiral Gehman 2-2-03*
Investigation Techniques and Methods

Comprehensive systematic method (a suggested practice)

- Gather data.
- Create time line.
- Create fault tree.
- Merge fault tree and time line to create events and causal factor tree.
- Further investigate root cause.
- Perform cause test.
- Document root cause, contributing factor(s) and other significant observations.
- Each finding (root cause, contributing factor or observation) should have a recommendation in the final report.
Implementing the Process

Classic phase sequence (step-by-step)

| Initiation | Fact finding | Analysis | Integration | Findings | Report |

Real-life phase sequence (overlapping and combined)

Initiation and fact finding
Analysis and integration
Findings and report
Investigation Techniques and Methods

- Depth of investigation is determined by the severity of the mishap and potential for reoccurrence.

- A variety of methods can be used to determine the causes and contributing factors.

- Methods listed, suggested, and briefly described in NASA Procedures and Guidelines for Mishap Reporting, Investigating & Recordkeeping (NPG 8621.1):
  - Evidence and data analysis
  - Events and causal factors diagramming
  - Fault tree analysis
  - Management Oversight and Risk Tree (MORT)
  - Root cause analysis
  - Change analysis
Data Collection

Initially Focus on “WHAT HAPPENED”

- **NOT** “Why It Happened.”
  Do Not Fixate on Causes.

- **NOT** “How Do We Prevent It Again or Solve the Problem.”

Investigating an Incident and Fixing the Problem are Two Separate Things... Keep Them Separate.
Fact Finding - "What Happened"

Comprehensive Search Should Include:
Hardware
Software
Procedures & Communications
Facilities
Environment
People (technicians, operators, maintainers, supervisors, management, and executives)
Company/Organization
Data Collection – Some Sources of Data

- Audio (during accident, of meetings e.g., PAR, COFR)
- Video & photographs
- Computer aided design, 3-D simulation, flight simulation
- Telemetry & radar
- Hardware design drawings, as-built configuration & debris
- Quality records on materials & processes (manufacturers, suppliers, operations, engineering)
- Maintenance & inspection records
- Info. on chemical, radiation, thermal, structural, mechanical, electrical and biological changes in system or processes
- Existing fault trees & FMEAs
- Hazard analysis & safety analysis
- Risk assessment and PRA
- Policies and procedures (including stamped job cards/procedures)
- Problem reports, corrective action reports, anomaly reports and/or mishap reports
- Interviews & initial witness statements
- Time cards, training records, certification records
- Medical evidence
- Company records (budget, layoffs, past reports, hiring practices)
- Weather data